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เทคนิคการสรางงานนําเสนออยางมืออาชีพ 
ดวย ProShow Gold 

 

เทคนิคการติดต้ังโปรแกรม ProShow Gold 
โปรแกรม ProShow Gold เปนโปรแกรมสําหรับการเรียงลําดับภาพเพื่อการนําเสนอแบบ

มัลติมีเดียที่มีความสามารถ สรางผลงานไดในระดับมืออาชีพดวยเทคนิคพิเศษมากมาย ใชงานได

งายเหมาะสําหรับการสรางงานนําเสนอสื่อการเรียนการสอน การแนะนําอัตชีวประวัติ สามารถ

เขียนชิ้นงานออกมาในรูปแบบของวิดีโอซีดี 

 
การติดต้ังโปรแกรม 

การติดตั้งโปรแกรมทําไดงายๆ ดวยการดับเบิ้ลคลิกที่ไฟล psgold_25_1635.exe ดังใน

ภาพขางลางนี้ 

 
จะพบกับกรอบหนาตาง ProShow Gold 2.5 Installation ใหคลิกที่ปุม Next 
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การสรางงานนําเสนอดวย ProShow Gold 2 

หนาตางถัดไปจะเปนกรอบแจงเตือนการอัพเกรดฟรีสําหรับผูลงทะเบียนจัดซื้อผลิตภัณฑ 

จากทางบริษัท (ถาไมมีเวอรชั่นเดิมจะเปนการติดตั้งใหมและตองลงทะเบียนใหมดวย) คลกิที ่Next 

ตามระเบียบอันดีงามตอไปไดเลย อยาชา... 

    
หนาตาง License Agreement ยอมรับในลิขสิทธิ์ของเขาแตโดยดี (ถาไมยอมรับก็ติดตั้ง

ไมไดอยูแลว) หนาตางถัดไปคือตําแหนงติดตั้งโปรแกรม คลิก Next ไดเลย 

    
หนาตางถัดมาจะถามวาตองการสรางไอคอนโปรแกรมที่ตําแหนงใดบาง Start Menu, 

Desktop และ Quick Launch เลือกเอาตามชอบ แลว Next ถึงขั้นนี้ก็พรอมที่จะติดตั้งโปรแกรมได

แลวคลิกที่ปุม Install ไดเลย 

     

 

 

ติดตั้งเสร็จแลว ตองทําการรีสตารทเครื่องกอน 

นะครับ เพื่อใหมีการตั้คาในรีจิสตร้ีของระบบ 

ข้ันตอนตอไปจะเปนการลงทะเบียนเพื่อใหใชงาน

ระบบไดตลอดไป 

งานเทคโนโลยีสารสนเทศ  โรงเรียนเบ็ญจะมะมหาราช 
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การสรางงานนําเสนอดวย ProShow Gold 3 

การลงทะเบียนใหดับเบิ้ลคลิกไฟลชื่อ tmg-psg25.exe ในโฟลเดอร ProShowGold\ 

keygen จะปรากฏหนาตางการลงทะเบียนดังภาพลาง (กรอบขวามือ) 

   
ใหใสชื่อของคุณ หมายเลขโทรศัพท (อยาใสมั่วแบบ 0123456789 นะครับใชไมได) แลว

คลิกที่ปุม Generate จะไดหมายเลข Unlock password เพื่อนําไปลงทะเบียนตอไป 

    
 

เปดโปรแกรม ProShow Gold ไปที่เมนู Help คลิก

ที่ Enter Registration Key(s) จะเปดกรอบสําหรับ

ลงทะเบียนขึ้นมาใหกรอกชื่อ หมายเลขโทรศัพท 

และหมายเลขลงทะเบียนลงไป ถาถูกตองจะพบ

กับขอความแสดงความยินดีดังดานซายมือ 

 
 

เปนอันเสร็จส้ินสมบูรณสําหรับการติดตั้งโปรแกรม ProShow Gold ใหสามารถใชงานได

ครบถวนทุกคุณสมบัติแลว เหลือเพียงศึกษาเทคนิคตางๆ เทานั้น 

งานเทคโนโลยีสารสนเทศ  โรงเรียนเบ็ญจะมะมหาราช 
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การสรางงานนําเสนอดวย ProShow Gold 4 

เทคนิคการติดต้ัง Absolute Sound Recoder 

โปรแกรมสําหรับการบันทึกเสียงในเครื่องคอมพิวเตอรมากมาย ซึ่งมีความสามารถที่

แตกตางกันออกไป สําหรับการสรางงานนําเสนอนี้ผูเขียนพบวามีโปรแกรมเล็กๆ ที่ใชงานงาย 

คุณภาพ และรูปแบบการบันทึกเสียงมีมากมาย ครบถวนตามที่ตองการ คือโปรแกรม Absolute 

Sound Recorder ซึ่งวิธีการติดตั้งก็ไมมีอะไรยุงยาก สามารถคลิก Next and Next ไดเลย 

   
เพียงดับเบิ้ลคลิกที่ไฟลติดตั้ง ชื่อ absrecorder.exe ขนาด 2.3 MB ก็จะปรากฏหนาจอ

ชวยเหลือการติดตั้งดังภาพบน 

 

   
เหมือนกับโปรแกรมทั่วๆ ไปคือตองยอมรับลิขสิทธิ์ของโปรแกรมเขากอนเลือกในวงกลม

แดง แลวก็ Next จะปรากฏหนาตางแสดงโฟลเดอรติดตั้ง คลิก Next ไดเลย 

งานเทคโนโลยีสารสนเทศ  โรงเรียนเบ็ญจะมะมหาราช 
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การสรางงานนําเสนอดวย ProShow Gold 5 

   
โปรแกรมจะถามใหตั้งชื่อเมนูโฟลเดอร และการสรางปุมไอคอนโปรแกรมบนหนาจอ ก็ให

คลิก Next ผานไปไดเลย 

   
โปรแกรมจะแสดงรายละเอียดวาพรอมจะติดตั้งแลว คลิกที่ปุม Install รอจนเสร็จ 

   
เมื่อโปรแกรมติดตั้งเสร็จคลิกที่ปุม Finish จะปรากฏหนาตางโปรแกรมดังภาพขวามือ ให

ลงทะเบียนโปรแกรมดวยการคลิกที่เมนู Help > Register กรอกชื่อผูใชงานและเลขทะเบียนจาก

ไฟล Readme.txt ก็เปนอันเสร็จส้ิน ใชงานไดเลย 

งานเทคโนโลยีสารสนเทศ  โรงเรียนเบ็ญจะมะมหาราช 
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การสรางงานนําเสนอดวย ProShow Gold 6 

เทคนิคการติดต้ัง Nero SoundTrax 
โปรแกรม Nero SoundTrax เปนชุดโปรแกรมที่มาพรอมแลวในโปรแกรมสําหรับการเขียน

ซีดีชื่อดังคือ NeroBurningRom ตั้งแตเวอรชั่น 5.0 เปนตนมา จึงไมขอแสดงรายละเอียดใน 

การติดตั้งโปรแกรม 
 

 
 

เมื่อเรามีโปรแกรมสําหรับการทํางานครบถวนแลว ตอไปก็จะเปนขั้นตอนในการเตรียม

ความพรอมสําหรับการนําเสนอ ซึ่งมีรายละเอียดปลีกยอยเชิงเทคนิคคอนขางมากทีเดียว เพื่อให

การนําเสนอผลงานของเรามีความสมบูรณ นาสนใจ ดังนี้ 

1. การเตรียมวัตถุดิบ หมายถึง การเตรียมขอมูลเร่ืองราวที่จะนําเสนอในเชิงลึกทั้ง

ประวัติความเปนมา  ส่ิงที่นายกยองเปนเกียรติยศ รางวัล/การยกยองชมเชยที่ เคยได รับ 

สภาวการณปจจุบัน ความมุงหวังหรือทิศทางในอนาคต เชน การนําเสนอที่เกี่ยวกับหนวยงานก็

จะตองเสาะหาประวัติของการกอตั้ง ความเปนมา ชื่อเสียง/เกียรติยศ ผลงานในปจจุบัน และ

ทิศทางพัฒนาในอนาคต 

2. การเตรียมภาพ ส่ือประกอบ ที่เกี่ยวของกับเร่ืองราว ใหไดมากที่สุด ในมุมมองที่

แตกตางกันออกไป ปรับแตงความคมชัด สีสัน ขนาดของภาพใหเหมาะสม ภาพถายที่เปนแนวตั้ง

อาจจะตองมีการปรับแตงใหมใหอยูในแนวนอน ดวยโปรแกรมตกแตงภาพอยาง PhotoShop 

งานเทคโนโลยีสารสนเทศ  โรงเรียนเบ็ญจะมะมหาราช 
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การสรางงานนําเสนอดวย ProShow Gold 7 

3. การเขียนบท (Script) นับวาเปนหัวใจสําคัญของการนําเสนอเรื่องราวที่ดี ไมวาจะ

เปนการนําเสนอเรื่องราวผานสื่อนําเสอ การผลิตรายการโทรทัศน วิทยุ หรือแมแตการแสดงบนเวที 

เพราะบทจะเปนตัวกําหนดรายละเอียดของงาน เชน เสียงประกอบ เสียงบรรยาย ภาพที่นําเสนอ 

ลักษณะการเคลื่อนที่ของภาพ (กลอง) มุมมอง (มุมกลอง) และตําแหนงของตัวละคร ซึ่งการเขียน

บทสําหรับการนําเสนอผานสื่อแตละแบบจะแตกตางกันเล็กนอยในรายละเอียด ในที่นี้จะเนน

เฉพาะการนําเสนอผานภาพนิ่งดวยโปรแกรม ProShow เทานั้น 

เรามาดูกันกอนวาเรามีคุณสมบัติของนักเขียนบทที่ดีแลวหรือยัง? ลองสํารวจตัวเองดู 

1. ตองเปนคนชางคิด ชางฝน สามารถจินตนาการเรื่องราวไดตอเนื่องและเขียนเปนคํา

บรรยายพรรณนาออกมาได 

2. ตองเปนคนอยากรูอยากเห็น (แตไมใชสอดแนม) มีความขยันหมั่นบันทึก การรูและ

เห็นมากยอมมีขอไดเปรียบในการจินตนาการ และการจดบันทึกอยางสม่ําเสมอจะทําใหเรามี

ขอมูลสําหรับการเลือกและตัดสินใจมาก 

3. ตองรูจักใชภาษา  คือใชภาษางายๆ ส้ัน  กระชับ ตรงประเด็น  เปนภาษาที่ ส่ือ

ความหมายไดทันที พูดงายๆ คือไมตองมาแปลภาษาไทยเปนไทยอีก คําบรรยายจะตองเขาใจงาย

ไมใชศัพทสูง คําพูดตองไมแนนจนเกินไป (จะกลายเปนรายการขาวไป) คําบรรยายจะตองชวยให

เกิดการโนมนาวผูชมคลอยตามไปกับภาพที่เรากําลังนําเสนอ 

4. ตองเขาใจจุดมุงหมายของการนําเสนอในเรื่องนั้นๆ บทจะตองตีกรอบใหผูฟงคลอย

ตามอยางเปนขั้นตอน พยายามใหภาพเปนตัวชวยเลาเรื่องโดยไมตองใชคําพูดมากมาย เพราะ

ภาษิตจีนบอกวา ภาพเพียงภาพเดียวอาจแทนที่คําพูดไดมากกวา 1,000 คํา 

5. ตองมีความเพียร มีวินัยและทํางานเปนทีมได ความเพียรคือการพยายามเขียนๆๆๆ 

และปรับแกไขใหสมบูรณ การมีวินัยคือตองบังคับตนเองใหงานจบทันเวลา และแนนอนเราตอง

ทํางานกับคนอ่ืนๆ เพื่อใหงานลุลวงจึงตองมีความไววางใจกัน 

ลําดับขั้นตอนการเขียนบทนําเสนอ (Presentation Script) 

1. การเขียนโครงเรื่องและการดําเนินเรื่อง (Plot or Treatment) เปนการเรียบเรียง

เร่ืองราวอยางยอใหครอบคลุมประเด็นหลักทั้งหมด ทิศทางการดําเนินเรื่องเปนไปในลักษณะใด 

สภาพบรรยากาศในเรื่องตั้งแตเร่ิมตนจนถึงบทสรุปสุดทายเปนอยางไร รวมทั้งรูปแบบการนําเสนอ

จะใชรูปแบบใด (เลาจากจุดเริ่มตนจนถึงจุดสุดทาย หรือจะนําความสําเร็จมาเลากอนยอนสูอดีต

และทิศทางในอนาคต) รูปแบบการเขียนไมไดมีการกําหนดรูปแบบไวตายตัว สวนใหญจะเขียนใน

ทํานองการเลาเรื่องวามีอะไรเกิดขึ้นบาง เปนโครงเรื่องยอ ในบางเรื่องที่มีความซับซอนมากอาจจะ

งานเทคโนโลยีสารสนเทศ  โรงเรียนเบ็ญจะมะมหาราช 
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การสรางงานนําเสนอดวย ProShow Gold 8 

มีการแจกแจงรายละเอียดออกไป ถาในทางการเขียนบทภาพยนตรจะเรียกวา สกรีนเพลย 

(Screenplay) 

การเขียนเรื่องยาวหรือสกรีนเพลยนี้ เปนการเขียนอยางพรรณนาใหหลับตามองเห็นภาพ 

ทั้งนี้การเขียนยิ่งละเอียดยิ่งดี อาจจะกลาวถึงคําพูดและเสียงประกอบในแตละชวงตอนไวดวย 

เพราะจะทําใหการเขียนบทงายขึ้น 

2. การเขียนบัตรเรื่อง (Story Board Cards) เปนการนําเอาเรื่องยอมาตีเปนภาพ และ

คําบรรยายตั้งแตเร่ิมตนจนบทสุดทาย โดยใชกระดาษแข็งขนาด 4*6 นิ้ว ในกรอบสี่เหลี่ยมสําหรับ 

การวาดภาพประกอบ อาจเปนภาพโครงราง 

หรือภาพการตูนลายเสนแสดงรายละเอียดของ

เร่ือง เพื่อใหชางภาพถายภาพไดตรงใจคน

เขียนบท มุมขวาจะเปนหมายเลขลําดับบัตร 

ถัดมาจะเปนรายละเอียดของภาพ (มุมกลอง) 

และเทคนิคตางๆ  สวนลางสุดจะเปนคํ า

บรรยายและเสียงประกอบ 

บัตรเรื่องนี้แมเราจะเรียงลําดับไวแลว ก็ยังสามารถจัดเรียงสลับไดเพื่อใหเนื้อหามีความ

ถูกตองสมบูรณล่ืนไหลไมสะดุด 

3. การเขียนบท (Script Writing) เปนการนําเอาเนื้อหาที่ผานการจัดเรียงอยางถูกตอง

แลวจากบัตรเรื่องมาเขียนลงในตารางเพื่อสรางความตอเนื่องและสะดวกในการทํางาน ทั้งการจัด

เรียงลําดับภาพ การบันทึกเสียงบรรยายและเสียงประกอบตางๆ  
บทเรื่อง ............................................................................................................................... หนาที่ .......... 

หนวยงาน ......................................................................................................... ความยาว .................นาที 

ผูเขียนบท ............................................................. ผูบรรยาย .................................................................... 

ลํา
ดับ
ที่ 

ภาพ/การเคล่ือนที่ เทคนิค 

เว
ลา

(s
) 

คําบรรยายและเสียงประกอบ 

1     

 
2     

 
3     

 

 ลําดับที่....... 

 ภาพ .......... 

 .................. 

 เทคนิค ....... 

 .................. 

คําบรรยาย/เสียง .............................................................. 

........................................................................................ 

....................................................................................... 
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ในแบบฟอรมการเขียนบทจะมีชองเพิ่มเติมรายละเอียดในขั้นตอนการผลิตคือ 

เทคนิค หมายถึง เทคนิคการปรับเปลี่ยนผสมภาพในแตละเฟรมใชเทคนิคใด เชน การตัดชนกัน 

(Cut in) การกวาดภาพรูปแบบตางๆ (Wipe) การเลือนภาพเขาออก (Fade 

in, Fade out) และการเลือนภาพเขาหากัน (Dissolve) 

เวลา หมายถึง ระยะเวลาของภาพที่ปรากฏในชวงนี้มีหนวยเปนวินาที ใชเพื่อการควบคุม

ความยาวของเรื่องใหกระชับ ตรงตามเวลาที่กําหนด 

การเขียนบทโทรทัศนที่ดีนั้น คงไมสามารถบอกถึงรายละเอียดใหเปนตัวหนังสือได การ

ฝกฝนในการเขียนอยางสม่ําเสมอและดูตัวอยางจากรายการสารคดี การนําเสนอตางๆ ที่ดีๆ แลว

นํามาประยุกตใชใหเหมาะสมกับงานของเราจะเปนการดีที่สุด เมื่อเขียนบทเสร็จแลวควรอาน

ทบทวนอีกครั้งพรอมจับเวลา ถายังไมพอใจในจุดนั้นอีก เคล็ดลับที่ดีอยางหนึ่งคือ การอาน

ดังๆ จะเห็นความไมเหมาะสมของบทไดอยางชัดเจน หรือใหคนอื่นๆ ชวยอานดูจะพบขอบกพรอง

ไดงาย 
หลักสําคัญในการเขียนบทที่ดี 

1. บทที่ดีจะตองมีแกนของเรื่อง (Theme) เปนจุดสําคัญที่สุดของเนื้อหา เพื่อไมให

เนื้อหาเบี่ยงเบนไปจากจุดสําคัญของเรื่องมากเกินไป 

2. บทนําเสนอควรมีการวางโครงเรื่องที่ดี ตั้งแตการนําเรื่องชวนใหติดตาม มีการถวง

เร่ืองและขยายรายละเอียด บททุกเรื่องจะตองมีจุดสุดยอด (Climax) ของเรื่องและการสรุปปดใน

ตอนทาย อัตราสวนของเนื้อหาทั้งหมดที่เหมาะสมคือ บทนําไมควรยาวเกิน 10% เนื้อหา 80% 

และสรุปปดทายอีก 10% 

3. ภาษาของบทนําเสนอควรมีความสละสลวยและลื่นไหลไปตามเนื้อเร่ือง ควรใช
ภาษาพูดมากกวาภาษาเขียน สรางความรูสึกใหเหมือนกับวากําลังคุยกับผูดู คําสั้นกระชับที่เขาใจ

งาย ใหความรูสึกรวมไปกับการแสดงภาพประกอบ 

สรุปอีกครั้ง “การเขียนบทที่ดี ก็คือ เริ่มตนใหต่ืนเตน ดําเนินเรื่องใหราบรื่น และจบ
ทายใหประทับใจ” 
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ข้ันตอนการสรางงาน 
ในการทํางานที่เกี่ยวกับระบบไฟลคอมพิวเตอรเพื่อไมใหเกิดความสับสน ควรที่จะสราง

ระบบเก็บงานในโฟลเดอรเปนการเฉพาะ เพื่อใหคนหาและจัดการไฟลไดงาย เชน โฟลเดอรเก็บ

งานและมีโฟลเดอรยอยสําหรับเก็บไฟลภาพ ไฟลเสียงที่เกี่ยวของ 

 
 

การบันทึกเสียงบรรยายและเสียงประกอบ 
หลังจากการเขียนบทนําเสนอและแกไขปรับปรุงจนเปนที่พอใจแลว ลําดับตอไปจะเปน

ข้ันตอนการบันทึกเสียงบรรยายและเสียงประกอบ ซึ่งเราจะใชเครื่องมือพื้นฐานที่หาไดงาย มี

คุณภาพพอสมควร และสะดวกในการใชงาน 

อุปกรณที่ตองใชในการบันทึกเสียงประกอบดวยไมโครโฟน หัวตอแปลงสําหรับแจค

ไมโครโฟนปกติมาเปนขั้วตอเขากับ Mic in ใน Sound Card เครื่องคอมพิวเตอร ซีดีเพลงประกอบ

ที่เหมาะสม หรือไฟลเพลง MP3 และหองที่มีความเงียบพอประมาณ 
การตอพวงอุปกรณ 

ตัวแปลงขนาดแจคไมคใหญ > เล็ก แจคไมคเดิม 
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ขั้นตอนการบันทึกเสียงบรรยาย 
การบันทึกเสียงบรรยายดวยโปรแกรม AbsoluteSound Recorder นั้นเราจะเริ่มจากการ

คลิกเลือกโปรแกรมใหทํางานจากไอคอนบนหนาจอหรือจากเมนู Start > Programs > Absolute 

Sound Recorder เพื่อทําการตั้งคาการทํางานของโปรแกรมดังนี้ 
การต้ังคาการบันทึกเสียงที่เมนู Options 

   
 

กอนทําการบันทึกเสียงจะตองมีการปรับแตงกันกอน ดวยการคลิกที่ปุม Options เพื่อเขา

ไปปรับแตงดังนี้ 

1. โฟลเดอรเก็บเสียงที่บันทึกแลว (Save Path) ใหกําหนดไวที่โฟลเดอรงานของเราจาก

ตัวอยางจะเก็บไฟลเสียงไวในโฟลเดอร Sound 

2. กําหนดรูปแบบของไฟลเสียงที่บันทึก ในภาพตัวอยางเลือกเปนชนิด MP3 บันทึกที่

คุณภาพระดับ 44100 Hz, 128 kbps ถาเลือกเปน WAV, WMA ขนาดไฟลจะใหญกวา 

3. กําหนดระยะเวลาการบันทึก ในตัวอยางเลือก No Limit สามารถกําหนดความยาว

ตามตองการไดจากชองตัวเลือกดานลาง 

เมื่อเปนที่พอใจแลวก็คลิกที่ปุม OK เพื่อดําเนินการในขั้นถัดไป 
การต้ังคาในแถบ Recording Controls 
ในแถบตัวเลือกนี้จะเปนการตั้งคาสําหรับแหลงของเสียง (Source) ที่ตองการบันทึก ใน

กรณีของเราคือการเลือกบันทึกจากไมโครโฟน (แตตัวโปรแกรมสามารถจะบันทึกเสียงจากแหลง

อ่ืนๆ ได เชน จากการเลนแผนซีดี จากชองตอ Aux, Line in และอื่นๆ ข้ึนอยูกับซาวการดรุนที่มีอยู

ในเครื่องนั้นสนับสนุนหรือไมดังภาพในหนาถัดไป 
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จากภาพบน เราเลือกบันทึกจากไมโครโฟน จะมีปุมสไลดเพื่อการปรับความแรงระดับ

สัญญาณที่ไดรับจากไมโครโฟน (แตละยี่หอจะไมเทากัน ตองทดลองบันทึกและเปดฟงเสียงกอน)  

หากระดับความดังที่ไดยังไมเปนไป

ตามที่ตองการใหคลิกที่ปุม  Advanced 

เพื่อเขาไปปรับการ Boot เพิ่มไดดังภาพ 

 

ทั้งนี้ ข้ึนอยูกับคุณภาพซาวดการด

และไมโครโฟนที่นํามาใชดวยใหทดลอง

ดูกอนการบันทึกเสียง 
 

การต้ังคาในแถบ Playback Volume Controls 

 
เฉพาะในแถบนี้ใหกําหนดหยุดการทํางานของไมโครโฟน (Mute) ขณะฟงเสียงที่บันทึก 

เพื่อปองกันการยอนกลับของสัญญาณ (Feedback) จะมีเสียงหวีดหอนเกิดขึ้น 

การต้ังคาในแถบ File Info 

ในแถบนี้จะเปนการแสดงรายละเอียดของไฟลที่เราไดบันทึก สามารถเปลี่ยนชื่อไฟลและ

รายละเอียดตางๆ รวมทั้งการทดลองฟงเสียงที่ไดบันทึกไวแลว ดังภาพในหนาถัดไป 
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ในขั้นตอนการบันทึกเสียงนั้น เราสามารถจะตรวจสอบคุณภาพของเสียงไดจากหนาตาง

แสดงผลในแถบ Record Sound ซึ่งจะแสดงในรูปของบารกราฟ และสเกลเสียงในภาพดานลาง 

ไมควรใหสเกลสีแดงเต็ม 

 
การบันทึกเสียง เมื่อตอพวงอุปกรณและปรับแตงเสียงทดสอบเปนที่พอใจแลว ก็สามารถ

จะบันทึกไดทันที ดวยการกดปุม Record สีแดง สามารถหยุดชั่วคราว (Pause) และบันทึกตอได 

หรือหยุดการบันทึก (Stop) เมื่อตองการ จะปรากฏชื่อไฟลที่บันทึกแลวในกรอบ File Info ดังภาพ

บน ซึ่งโปรแกรมจะตั้งชื่อใหเปน Untitled1.mp3, Untitled2.mp3, Untitled3.mp3,… ไปเร่ือยๆ ทกุ

คร้ังที่เร่ิมบันทึกเสียงใหม เราสามารถเปลี่ยนชื่อไฟลได 

การบันทึกเสียงบทบรรยาย ควรบันทึกเปนทอนๆ ตามเฟรมในบทที่ไดเขียนไวแลว เพื่อ

ความสะดวกในการผสมเสียง และลดการผิดพลาดในการอานบทยาวๆ ลงได การบรรยายที่ดีควร

จะมีการเนนหนักเบาในชวงตางๆ เหมือนกับการพูดกับผูชมใหเกิดความนาฟง จับใจ 
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การผสมเสียงบรรยายและดนตรีประกอบดวย Nero SoundTrax 

 
โปรแกรม Nero SoundTrax เปนโปรแกรมที่มาพรอมกับ NeroBerningRom ใชสําหรับ

การปรับแตงผสมเสียงตางๆ เขาดวยกัน เหมือนกับมีเครื่องผสมเสียง (Mixer) ในหองบันทึกเสียง

มาติดตั้งในคอมพิวเตอรของเรา ดังภาพบนซึ่งมีการใชงานงายๆ ดังนี้ 

1. การเพิ่มเสียงลงไปในแทรคเสียงที่ 1 (ในที่นี้จะนําไฟลเสียงเพลง Background เขามา

กอน 1 เพลง) ดวยการคลิกที่เมนู Inser > Audio File… จะมีกรอบใหเลือกเพลงที่ตองการนําเขา 

 

ปรับเสียงที่นี ่

2. เราสามารถปรับระดับความดังของเสียงและความสมดุลซายขวาได 
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การสรางงานนําเสนอดวย ProShow Gold 15 

3. ถาเสียงแบ็คกราวดยาวไมพอหรือตองการเปลี่ยนบรรยากาศใหเขากับเนื้อหาสามารถ
เพิ่มแทร็คเสียงเขาไปไดอีก โดยคลิกที่เมนู Insert > New Track จะเกิดแทร็ดเสียงใหมใหคลิก

เลือกที่แทร็คนี้และเพิ่มเสียงเขาไป (ตามขั้นตอนที่ 1) 

4. ตอไปเราจะเพิ่มแทร็คเสียงบรรยายเขาไป พรอมทั้งเสียงที่ไดบันทึกไว (ทําตามขั้นตอน

ที่ 3 แตไฟลเสียงบรรยายทั้งหมดจะอยูในแทร็คเดียวกัน) ดังภาพดานลาง 

 
แทรคเสียงที่ 1 แทรคเสียงที่ 2 

เสียงบรรยาย 1 เสียงบรรยาย 2 

5. ข้ันตอไปเราจะทําการปรับระดับของเสียงประกอบใหมีความดังลดลง เมื่อเสียง

บรรยายเริ่มข้ึน และจะเพิ่มความดังเสียงประกอบเมื่อจบคําบรรยายในแตละชวง ดวยการคลิกที่

แทร็คเสียงที่ 1 แลวไปที่เมนู Track > Add Volume Curve จะเกิดแนวเสนตรงเหนือแทร็คนั้น 

 
เสนระดับเสียงแทร็ค 1 เสนระดับเสียงแทร็ค 2 

เสียงบรรยายที่ 1 เสียงบรรยายที่ 2 

6. เราสามารถเพิ่มหรือลดเสียง ณ ตําแหนงใดๆ บนเสนระดับเสียงนี้ดวยการใชเมาส

คลิกที่ตําแหนงบนเสนแลวลดหรือเพิ่มระดับของเสียง จากตัวอยางจะเปนการลดระดับเสียงของ

แทร็คที่ 1 ใหผสานเขากับเสียงในแทร็คที่ 2 ดวย 
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การสรางงานนําเสนอดวย ProShow Gold 16 

7. ใชวิธีการดังตัวอยางขางตนสําหรับการผสมเสียงบรรยายจนครบทุกเฟรม การวาง

ตําแหนงของเสียงบรรยายแตละเฟรมใหมีชองวางเวลาไมเทากันได ดวยการขยีบตําแหนงของเสียง

บนแทร็คไปมา จนไดเวลาในการนําเสนอครบถูกตองตามบทที่กําหนดไว 

8. เมื่อปรับระดับของเสียงและการผสมเสียงบรรยายและเพลงประกอบตางๆ สมบูรณ

จนเปนที่พอใจแลวใหนําไฟลออกไปใชงานดวยการคลิกที่เมนู File > Export to Audio File… ซึ่ง

สามารถสงออกไดหลายสกุลทั้งไฟล WMA, Wave, MP3, MP4, Ogg (แนะนําใหใชนามสกุล 

Wave ไดคุณภาพเสียงที่ดีและใชงานไดดีใน ProShow Gold ตั้งชื่อไฟลแลวบันทึกเก็บไวใน

โฟลเดอร Sound 

9. ในตัวโปรแกรม Nero SoundTrax มีปล๊ักอิน (Plug in) สนับสนุนการปรับแตงเสียง

พิเศษ (Effect) มากมาย เชน เสียงกอง (Reverb) เสียงประสาน (Chorus) ดวยการเลือกแทร็คที่

ตองการเพิ่มเทคนิคพิเศษ ไปที่เมนู Inser > Effect Into > Track Effect Chain…  

   
จากกรอบบนเราจะเลือกที่ Add > Effect > Reverb.. จะไดกรอบหนาตางดานขวามือ 

เพื่อปรับแตงเสียงเพิ่มเติม เมื่อพอใจแลวปดหนาตางนี้ไป เสียงในแทร็คนั้นก็ไดเสียงพิเศษตาม

ตองการ ในแตละเทคนิคพิเศษจะมีคามาตรฐานตั้งไวใน Preset > สามารถเลือกใชงานไดโดยไม

ตองปรับแตงเอง 

หากไมพอใจตองการเอาเทคนิคพิเศษออกก็เพียงแตกลับมาที่หนาตางนี้อีกครัง้ คลกิลงบน

เทคนิคพิเศษ (กรอบสีเขียว แลวลบออก) 

10. หากตองการใหเสียงบรรยายแตละทอนมีเทคนิคพิเศษทางดานเสียงแตกตางกัน 

จะตองแยกเสียงบรรยายทอนนั้นๆ ออกไปอยูในอีกแทร็คหนึ่งแยกตางหาก 
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การสรางงานนําเสนอดวย ProShow Gold 17 

การเตรียมภาพกอนนําไปใชในโปรแกรม ProShow Gold 
1. ภาพที่จะนํามาใชงานสามารถใชภาพถายที่สแกนเปนไฟลแลว หรือภาพจากกลอง

ดิจิตอล โดยจัดเรียงลําดับดวยการเปลี่ยนชื่อเปนตัวเลข 

2. ปรับแตงความคมชัดของภาพใหเหมาะสม สดใส ภาพทุกภาพควรอยูในแนวนอนใน

อัตราสวน 4:3 หากภาพเปนแนวตั้งอาจจะตองใชโปรแกรมตกแตงภาพ เชน PhotoShop ชวยใน

การสรางภาพใหมใหเหมาะสมกับการใชงาน 

3. รวมภาพทั้งหมดไวในโฟลเดอรชื่อ Images หรือช่ืออ่ืนๆ ตามตองการ 

หมายเหตุ เนื่องจากโปรแกรม ProShow Gold ไมสนับการตั้งชื่อไฟลและโฟลเดอรเปน

ภาษาไทย ดังนั้นจึงควรหลีกเลี่ยงการตั้งชื่อไฟลภาษาไทย หากนํามาจากที่อ่ืนๆ ให

เปลี่ยนชื่อใหมเปนภาษาอังกฤษ เพื่อความสะดวกในการใชงานแทรกภาพและเสียง 

 

การใชงาน ProShow Gold 
เมื่อเปดโปรแกรม ProShow Gold ข้ึนมาจะพบกับหนาตางโปรแกรมดังภาพดานลางนี้ 

เมนูโปรแกรม โฟลเดอรงาน ไอคอนทางลัด พื้นที่แสดงตัวอยาง 

 
 

เฟรมภาพ แถบเสียง ปุมควบคุมการแสดงตัวอยาง เวลาโดยรวม เวลาของเฟรมนี้ 
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การสรางงานนําเสนอดวย ProShow Gold 18 

การสรางงานนําเสนอจากโปรแกรม ProShow Gold นั้นเมื่อเราเตรียมงานเขียนบทลําดับ

เร่ือง การเตรียมภาพประกอบ การบันทึกเสียงบรรยายและเสียงประกอบ ไวเรียบรอยแลว ข้ันตอน

สําคัญคือการจัดเรียงลําดับภาพใหสอดคลองกับเสียงบรรยาย 
 

 
 

ข้ันตอนการสรางงานของเราจากภาพดานบน ในวงกลมสีแดงคือโฟลเดอรเก็บภาพและ

เสียงในการสรางงานของเรา การนําเสนอในตัวอยางนี้เปนการทํา Music Video เพลงประกอบ

ภาพ คร้ังแรกในการไปผจญภัยในตางแดนคนละซีกโลกของครูมนตรี จึงใหชื่อวา My First Time 

โดยเลือกใชเพลงสากลชื่อ My First Time เปนเสียงประกอบไมมีคําบรรยาย ข้ันตอนการทํางานมี

ดังนี้ 

1. คลิกที่ไฟลเพลง My First Time ในโฟลเดอร Sound แลวลากมาวางในแถบ Sound 

track (โปรแกรมรองรับไฟลในหลายฟอรแมตแตในการใชงานจริงจะเปนไฟลนามสกุล .wav 

โปรแกรมจะทําการแปลงเพื่อนําเขาเองโดยอัตโนมัติ เหตุนี้เองในขั้นตอนการ Export เสียงจาก

โปรแกรม Nero SoundTrax จึงแนะนําใหสงออกเปนไฟล Wave) รอสักครูจนกวาการนําเขาจะ

สําเร็จ ปรากฏวา เพลงนี้มีความยาวทั้งสิ้น 3 นาที 15.44 วินาที 

2. ข้ันตอนที่สองเราจะเปลี่ยนโฟลเดอรไปที่ Images เพื่อเลือกภาพมาวางในชอง Slide 

โดยเริ่มที่การคลิกเมาสขวาที่ไสลดชองแรกเลือก Insert Blank Slide กอนแลวตอที่ภาพถายจาก
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การสรางงานนําเสนอดวย ProShow Gold 19 

เครื่องบินผานหนาตางมองเห็นปกเครื่องบินและทิวทัศนเบื้องลาง จากนั้นนําภาพที่ไปตอยัง

สถานที่ตางๆ ในออสเตรเลียมาวางลงตามลําดับ 

 
เทคนิคการเปลี่ยนภาพ เวลาในการเปลี่ยนภาพ เวลาในการแสดงภาพ ปุมแสดงตัวอยางงาน 

จากภาพบนจะเห็นวาเมื่อมีการนําภาพมาเรียงลงในแตละไสลด จะมีสัญลักษณ  

มาคั่นระหวางภาพแสดงเทคนิคการเลือนภาพเขาหากันจาก A -> B และมีคาตัวเลขบอก

ระยะเวลาที่ทําการเปลี่ยนภาพมีหนวยเปนวินาที และในไสลดแตละชองจะมีหมายเลขบอกลําดับ

ไสลดดานซายมือและมีตัวเลขบอกเวลาการแสดงภาพดานขวามือมีหนวยเปนวินาที 

3. เราสามารถแสดงตัวอยางของงานไดดวยการคลิกที่ไสลดภาพแรก และคลิกที่ปุมเลน

ในกรอบชุดควบคุมการแสดงภาพตัวอยาง 

 
4. การปรับแตงการเปลี่ยนภาพ ถาเราตองการใหโปรแกรมใสเทคนิคการเปลี่ยนภาพให

เราเองอัตโนมัติแบบสุมก็สามารถทําไดดวยการคลิกที่สไลดภาพใดๆ แลวกดปุม Ctrl+A หรือไปที่
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การสรางงานนําเสนอดวย ProShow Gold 20 

เมนู Edit > Select All เพื่อเลือกสไลดทั้งหมด แลวไปที่เมนู Slide > Randomize Transition จะ

เห็นวาปุม AB ระหวางสไลดเปลี่ยนไปหลายรูปแบบ 

5. หากตองการกําหนดการสรางเทคนิคการเปลี่ยนภาพเองก็สามารถทําได โดยเมื่อนํา
เมาสไปคลิกที่ปุม AB จะมีกรอบแสดงเทคนิคการเปลี่ยนภาพมาใหเลือกจํานวนมากดังภาพ 

 
เมื่อนําเมาสไปวางเหนือรูปแบบใด จะมีภาพตัวอยางแสดงผลใหดูที่มุมซายลาง ดานขวา

ลางสุดจะเปนรูปแบบที่เลือกใชบอยๆ ในการสรางงานครั้งกอน (ถายังไมเคยใชงานปุมจะมีจํานวน

นอยกวานี้) สวนแถวบนถัดไปเปนปุมเทคนิคมาตรฐานที่เลือกใชบอยสุด 

6. นอกจากเทคนิคพิเศษการเปลี่ยนภาพแลว ยังมีเทคนิคการเคลื่อนที่ของภาพในแตละ

สไลดเพื่อทําใหเกิดความรูสึกเสมือนหนึ่งมีการเคลื่อนไหวของกลอง เชน การขยับกลองจากซายไป

ขวา หรือขวาไปซาย (PAN) การดึงภาพเขามาใกลหรือถอยออกมาไกล (Zoom in and Zoom out) 

หรือการกม/เงยกลองจากบนลงลางหรือลางขึ้นบน (Tilt up or Tilt down) 

วิธีการงายๆ สําหรับมือใหมหัดสรางงานนําเสนอ คือการเลือกไสลดทั้งหมด (คลิกที่ไสลด

ใดๆ กดปุม Ctrl + A) แลวไปที่เมนู Slide > Random Motion Effect โปรแกรมจะทําการสุมใส

เทคนิคพิเศษใหกับสไลดแตละภาพอยางอัตโนมัติและมีความตอเนื่องสัมพันธกันใหทันที 

7. ในกรณีที่ไมตองการใหโปรแกรมใสเทคนิคพิเศษการเคลื่อนที่ของภาพให เราสามารถ
ทําการปรับแตงในแตละสไลดไดโดยตรงดวยการดับเบิ้ลคลิกที่สไลดที่ตองการกําหนดจะปรากฏวา 
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มีกรอบการกําหนด Motion and Effects ข้ึนดังภาพบน ในภาพซายคือจุดเริ่มตนแสดง

ไสลด ภาพขวาคือจุดสิ้นสุดการแสดงไสลด เราสามารถปรับเปลี่ยนตําแหนงภาพดวยการใชเมาส

คลิกที่ภาพเลื่อนไปตําแหนงที่ตองการไดโดยตรงทั้งสองภาพ หรือหากตองการความละเอียด

สามารถกําหนดคาตัวเลขในชองดานบนได (ในกรอบสวางภายในภาพคือบริเวณแสดงผลจริงของ

งานที่ปรากฏบนจอ) 

ในปุมดานซายมือยังเสริมเทคนิคพิเศษใหกับภาพไดดังนี้ 

 Image / Video หมายความวาสามารถนําเขาคลิปวีดิโอแทนภาพนิ่งได 

 Adjustments คือปุมที่ทําหนาที่ตกแตงภาพ แกไขภาพที่อาจจะมืดไปนิด สวางไป

หนอย ไมคอยสัมพันธกับภาพกอนหนาหรือภาพถัดไป ก็สามารถปรับเพิ่มเติมได 

 Motion Effects คือการกําหนดการเคลื่อนที่รูปแบบตางๆ ของภาพ 

 Captions คือการใสหัวเรื่องหรือคําอธิบายภาพนั้นๆ ลงไป รวมทั้งการกําหนดเทคนิค

พิเศษใหกับตัวอักษรนั้นๆ ทั้งดานรูปแบบตัวอักษร ขนาดและสีสัน รวมทั้งการ

เคลื่อนไหวของตัวอักษรในรูปแบบตางๆ  

 Sound คือการแทรกเสียงเฉพาะที่เกี่ยวกับภาพนี้ลงไปเปนกรณีพิเศษ ไมเกี่ยวกับ

เสียงบรรยายที่เปนแบ็คกราวด ดวยการนําเสียงมาจากไฟล หรือบันทึกเสียงจาก

ไมโครโฟนลงไปโดยตรง 
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การสรางงานนําเสนอดวย ProShow Gold 22 

 Background คือสีพื้นหลังในกรณีที่เปนภาพแนวตั้งจะมีเนื้อที่ขอบดานขางซายขวา 

สามารถกําหนดสีใหแสดงหลังภาพได คาปกติคือสีดําเปลี่ยนแปลงไดตามตองการ 

หรือจะใชไฟลภาพใดภาพหนึ่งเปนพื้นหลังก็ได 

 
ในการพิมพตัวอักษร เนื่องจากตัวโปรแกรมยังไมสนับสนุนภาษาไทยโดยตรง แตก็

สามารถแทรกลงไปไดดังภาพบน ในชอง Captions และ Text จะอานไมออก แตในภาพจะอานได

ตามปกติ 

เทคนิคในการทําใหการแสดงผลภาษาไทยดูดี ในการพิมพถามีสระบนหรือลางใหเคาะเวน

วรรคหนึ่งเคาะกอน คอยพิมพตัวอักษรถัดไปจะแสดงผลไดสวยงาม เมื่อกําหนดทุกอยางไดตาม

ตองการแลวคลิกที่ปุม Done มุมขวาลางเพื่อกลับไปที่งานดังเดิม 

8. หลังจากการกําหนดเทคนิคพิเศษตางๆ จนเปนที่พอใจแลว ก็ลองแสดงตัวอยางดู จาก

เฟรมแรกไปจนเฟรมสุดทาย คอยสังเกตที่ตําแหนงสไลดตางๆ ขณะแสดงผล ถาจุดใดบกพรองให

บันทึกไวเพื่อทําการแกไขในภายหลัง 

9. ทําการแกไขจุดบกพรองตางๆ ตามที่บันทึกไว จนเปนที่พอใจใหบันทึกจัดเก็บไฟลดวย

การคลิกที่เมนู File > Save หรือ กดปุม Ctrl + S หรือคลิกที่รูปแผนดิสเก็ตตก็ได ตั้งชื่อไฟลตาม

ตองการจากตัวอยางนี้ บันทึกในชื่อ MyFirstTime.psh ซึ่งสามารถแกไขเพิ่มเติม ปรับเปลี่ยนไดใน

ภายหลัง 
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การบันทึกช้ินงานลงใน VideoCD/DVD 
โปรแกรม ProShow Gold สามารถบันทึกงานที่ทําสําเร็จแลวลงในแผน CD/DVD เพื่อ

นําไปเปดในเครื่องเลนซีดี/ดีวีดี ทั่วไปได หรือจะเปดในเครื่องคอมพิวเตอรที่ไมมีโปรแกรม 

ProShow Gold ติดตั้งอยูเลยก็ไดแบบ AutoRun 

ตัวอยางนี้จะเปนการสรางแผนวีซีดีธรรมดา (เพราะไมมีไดรวเขียนดีวีดี) ใหคลิกที่เมนู 

Create > Video CD หรือกดปุม Alt + V หรือคลิกที่ปุมไอคอน VideoCD ก็ไดจะพบกับหนาจอรูป

ขางบนนี้ จะพบกับหัวขอตางๆ ดังนี้ 

• Menus คือการสรางเมนูสําหรับแสดงกอนเริ่มเลน (ไมมีความจําเปนนัก เพราะ

เรามีอยูเร่ืองเดียว ตอนเดียว 

   
• Shows คือการกําหนดไตเติ้ลผูผลิตหรือขอความแสดงลิขสิทธิ์ตางๆ ถาไมมีจะเอา

ไตเติ้ลที่ ProShow สรางไวใหก็ได 
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• Output Options สําหรับการกําหนดรูปแบบของไฟลงานวาตองการอยางไร เชน

การแสดงภาพนิ่ง วีดิโอ ถาเปนวีดิโอจะตองกําหนดดวยวาเปนระบบใด NTSC 

หรือ PAL (ประเทศไทยใชระบบ PAL) การกําหนดไดรวเขียนซีดี (ถามีไดรวเขียน

ซีดีโปรแกรมจะเลือกเองอัตโนมัติ ถาไมมีโปรแกรมจะเลือกเขียนเปน Image File 

เพื่อนําไปเขียนในเครื่องอื่นได) รวมทั้งจะใหโปรแกรมนําภาพนิ่งตนฉบับไปสราง

โฟลเดอรไวในซีดีหรือไม (ถามีพื้นที่เหลือ) 

• PC Autorun คือการกําหนดใหโปรแกรมสรางไฟลเลนซีดีอัตโนมัติในคอมพิวเตอร 

ตองการแสดงโชวแบบวนไมรูจบหรือไม ขนาดของการแสดงผลบนจอเริ่มตนที่

ขนาดใด และสูงสุดที่ขนาดใดเพื่อใหชิ้นงานยังคงคุณภาพ นอกจากนั้นโปรแกรม

ยังมีการเขารหัสปองกันการชมตามระยะเวลาที่กําหนดไดดวย 

 
เมื่อกําหนดคาตางๆ ครบถวนถูกตองแลวก็คลิกที่ปุม Create ไดเลย โปรแกรมจะทําการ

สรางไฟลวีดิโออาจจะใชเวลามากนอยแลวแตทรัพยากรเครื่องของทานวาเร็วเพียงไร เมื่อเสร็จส้ิน

โปรแกรมจะใหใสแผนซีดี หรือถาไมมีไดรวเขียนโปรแกรมจะถามวาจะเก็บไฟลงานไวที่ใดเพือ่นาํไป

เขียนตอในเครื่องอื่นๆ 
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นอกจากนี้แลวโปรแกรม ProShow Gold ยังสามารถสรางงานอื่นๆ ไดอีกมาก เชน การ

สรางสื่อนําเสนอบนเว็บไซต การแชรไฟลใหกับบุคคลอ่ืนๆ การสรางไฟลสําหรับแสดงดวยตนเอง 

(Executable) การสรางภาพแสดงหนาจอคอมพิวเตอรในชวงพักการทํางาน (Scree Saver) 

 

ซึ่งความสามารถเหลานี้ ทานคงจะสามารถศึกษาเพิ่มเติมดวยตนเองได จากการชวยเหลอื

ของโปรแกรมเมื่อคลิกที่ปุม Help แนนอนทานตองใชความสามารถพิเศษในการทําความเขาใจ

จากภาษาอังกฤษเพิ่มเติม 

การหมั่นฝกฝนและกลาที่จะทดลองทําจะชวยใหทานประสบผลสําเร็จ หวังวาคูมือเลมนี้

และไฟลตัวอยางในแผนซีดี จะชวยใหทานสรางงานไดประสบผลสําเร็จ.... 

พยายามตอไปครับ ขอเปนกําลังใจใหคุณ....ดวยใจจริง 

 

มนตรี  โคตรคันทา 
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